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Organisation and conditions for assessment 
 
 
The assessment is designed to test each candidate’s ability to apply knowledge and understanding and 
practical skills, developed through study of the Database Systems and Using Information Units. The 
mark out of 30 should be submitted to the SQA unscaled. This will be combined with the examination 
mark out of 70 to establish the candidate’s overall grade of award. This mark should also be used in 
preparation of estimate grades. 
 
The notional design length for the assessment is 8 - 10 hours. However, a candidate may be allowed 
longer than this if required.  
 
The assessment is to be undertaken under “open book” conditions, but under supervision by the tutor 
to ensure that the work submitted is the candidate’s own work. The tutor may give the candidate hints 
and/or help if requested. Any such help should be reflected in the marks awarded. Once the task has 
been completed and marked, it should not be returned to the candidate for further work. 
 
These instructions are designed to be used in conjunction with data files provided with the electronic 
distribution of the task.  These can be downloaded from the SQA secure website. 
 
The files to be downloaded should include : 

• The 2008/2009 Int 2 IS Coursework Task  
• Graphics for website 
• TVs database 
• Six Company Logos (Bright, PixelPerfect, PowerZ, TV2GO, Vision, Whyte) 

 
Candidates are not required to spend time entering data into a database.  Instead, the data should be 
prepared beforehand and provided to candidates by the centre. 
 
To facilitate this, database files for Microsoft Access and FileMaker Pro have been provided for this 
task.  The files contain or represent a number of tables with data entered.  The appropriate file(s) 
should be made available to the candidates. 
 
Centres using alternative relational database software can use the accompanying data files, which 
contain tab-delimited data required for the tables.  The centre should set up tables as appropriate 
within the database software and import the data provided.  The resulting database file should then be 
made available to the candidates. 
 
 



Notes 
 

• Candidates should be given a copy of the marking grid before starting the task so that 
they are aware of the mark distribution for each part. 

• It is essential that candidates use a relational database application for Part 2.  Task 1 of 
Part 2 must be completed and the database design form handed in for marking 
before the completed database design form is issued. 

• At the beginning of Part 2, candidates should be given the TVs database that contains the 
Models table.  During the coursework, the candidate will have to create the Manufacturer 
table and link the two tables together. 

• Task 4 of Part 2, asks the candidate to “Print out a copy of your design that shows the 
field types and validation check”.  This is to provide evidence that the correct field types 
have been used and all necessary validation checks implemented. Producing this printout 
is NOT part of the task and if a candidate has difficulty then the assessor should help 
them produce the printout without penalty. 
o In FileMaker Pro, to get a printout of the design, candidates should adhere to the 

following instructions. 
(1) Select the “Define” option from the File menu and then select the “Database” 

option from the sub-menu. 
(2) Click on the Tables tab. 
(3) Highlight both tables by clicking on the name of the first table then holding 

down the shift key and clicking on the other table. 
(4) Click on the Print button. 

 
o In MS Access, to get a printout of the design, candidates should adhere to the 

following instructions.   
(1) Select the “Analyze” option from the Tools menu and then select the 

“Documenter” option from the sub-menu. 
(2) Select the table(s) required and then click Options button. 
(3) Make sure that the following options are checked/selected: 

• Include for Table 
 Properties 
 Relationships 

• Include for Fields 
 Names, Data Types, 

Sizes and Properties 
• Include for Indexes 

 Names and Fields 
 

(4) Click on OK 
(5) The required table design is 

displayed on screen and can be 
printed. 
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• Task 7 of Part 2 requires a printout or hardcopy of the relationships. 
 

o Printing Relationships in FileMaker 8. 
(1) Select the “Define” option from the File menu and then select the “Database” 

option from the sub-menu. 
(2) Click on the Relationships tab then click on the Print button. 

 
o Printing Relationships in Access 

(1) Open the Relationships window. 
(2) Select the “Print Relationships” option from the File menu. 
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Intermediate 2 Information Systems  
Coursework Task 2008/2009 
 
 
Part 1 
 
McPhee’s is a company with many stores throughout the country selling televisions.  Recently, with 
the introduction of LCD and Plasma televisions, many customers are replacing their old televisions 
with modern flat screen televisions.  McPhee’s stock televisions made by six different manufacturers:  
Bright, PixelPerfect, PowerZ, TV2GO, Vision and Whyte. 
 
To try to obtain a greater share of the market, McPhee’s would like to have a website developed that 
will give details of their best selling televisions.  You have been asked to create a small sample 
website that will give McPhee’s some idea of what the final website would look like.  As it is only a 
sample, you do not need to create the entire website, just the home page and three other Web pages. 
 
The four Web pages you have to create are shown below. 
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Notes: 
o The home page is the opening page. 
o On all pages, clicking on “Home” in the navigation bar will take the user to the home page. 
o On all pages, clicking on “Bright” in the navigation bar will take the user to the Bright main 

page. 
o When either the television or the model number on the Bright main page is clicked, it will take 

the user to the details about that television. 
o The remainder of the links in the navigation bar do not need to be implemented as it is only a 

sample website. 
 
 
What you have to do  
 
Your assessor will give you access to a Web authoring application and a copy of the graphics required 
for the website.  You have to create the sample website shown on the previous page. 
 
When carrying out the following tasks, pay particular attention to the data objects, operations 
and formatting functions that you use. 
 

 Tasks Evidence Required 
1 a) Using the files provided by your assessor, create the website 

shown on the previous page ensuring that: 
o The home page is the opening page. 
o On all pages, clicking on “Home” in the navigation bar 

will take the user to the home page. 
o On all pages, clicking on “Bright” in the navigation bar 

will take the user to the Bright main page. 
o When either the television or the model number on the 

Bright main page is clicked, it will take the user to the 
details about that television. 

 
You should make sure that you format all the objects in the 
website so they match the ones shown on the previous page as 
closely as possible. 
 

b) Insert your name at the bottom of all Web pages and print out a 
copy of your website. 
 

Printout of website 

(8 marks) 
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You have to evaluate the suitability of the Web authoring application you used to produce the 
website.  Your assessor will give you a pro-forma that you should complete using the instructions 
below. 
 

 Tasks Evidence Required 
2 a) Identify three different types of data object used in the creation 

of the website. 
 

 b) Choose one of the data objects you identified above and describe 
two operations that the application allowed you to carry out on 
that object in the creation of the website. 

 
 c) Evaluate the online help of the application used to create the 

website.  Your evaluation should include details of two features 
of the online help. 

 

Evaluation of application 
to create the website. 

(6 marks) 
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Part 2 
 
Customers frequently ask technical questions like “Which televisions have at least 3 HDMI 
connections?” or “Which televisions are HD Ready?”.  Staff in McPhee’s stores, are unable to 
remember details like this, so it has been decided to create a database of the different television 
manufacturers and the models they make. 
 
Information about the television models has already been entered into a database.  A sample record is 
shown below. 
 

Model BR1576819 
Price (£) 139.99 
Company Bright 
TV type  LCD 
Screen size (inches) 15 
EPG (days) 0 
HD ready No 
Resolution  768 
Contrast ratio 400 
Brightness (cd/m2) 250 
Sound system  Virtual Surround Sound 
Audio output (watts)  4 
No Scart sockets  1 
S-Video No 
Component video  No 
No HDMI connections 0 
DVI connection No 
Power On (watts) 19 
Power Standby (watts) 0.7 

 



Information about each television manufacturing company has still be added.  The name of each 
company is unique and therefore suitable to use as a primary key.  McPhee’s would like the following 
information added: 
 

Company Founded Profit 
(£m) Logo Warranty 

(years) 
Manufacturing 

Country Finance 

Bright 22/05/1975 1045 
 

5 United Kingdom 18 months 

PixelPerfect 02/10/2005 22 
 

5 United Kingdom 24 months 

PowerZ 17/11/1988 356 
 

2 Japan 24 months 

TV2GO 30/12/1999 77 
 

1 USA None 

Vision 02/02/2002 6 
 

1 USA None 

Whyte 19/07/1982 14 
 

5 Russia 18 months 

 
• The warranty attribute can only take the values 1, 2 or 5. 
 
 

What you have to do: 
 

Tasks Evidence Required 
1. Your assessor will give you a blank database design form.  

Complete the form by filling in each of the field types and any 
validation that would be carried out for the information shown in 
the table above. 
 

Completed Database Design 
Form 

 
You must hand in your database design form to your assessor before going any further. 
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What you have to do (continued): 
 
Your assessor will have given you the completed database design form. 
 

Tasks Evidence Required 
2. Using the completed database design form issued by your 

assessor and a relational database application, create a table 
called Manufacturer  that can be used to store the information 
about each of the television manufacturing companies. 
 
(Note:  Your assessor will have provided you with the database 
file called TVs which contains the Models table.) 

3. The Warranty (years) field of the Manufacturer table can only 
contain the values 1, 2 or 5.  Alter the table so that the Warranty 
(years) field can only accept these values. 
 

4. Print out a copy of your design that shows the field types and 
validation check.  (If you are unsure how to do this, your 
assessor will be able to help you.) 
 

Printout of Manufacturer 
table design showing field 
types and validation check. 

5. Enter all the data into your Manufacturer table, taking care to 
ensure the data is entered as shown below.  Your assessor will 
give you an electronic copy of the six logos; one for each 
company. 

 

 

Company Founded Profit 
(£m) Logo Warranty 

(years) 
Manufacturing 

Country Finance 

Bright 22/05/1975 1045 
 

5 United Kingdom 18 months 

PixelPerfect 02/10/2005 22 
 

5 United Kingdom 24 months 

PowerZ 17/11/1988 356 
 

2 Japan 24 months 

TV2GO 30/12/1999 77 
 

1 USA None 

Vision 02/02/2002 6 
 

1 USA None 

Whyte 19/07/1982 14 
 

5 Russia 18 months 
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What you have to do (continued): 
 
6. Create a simple report/layout to display the entire contents of the 

Manufacturer table. 
 
Produce a printout using this report/layout ensuring that your 
name and all field names can be clearly seen on the printout. 
 

Printout of Manufacturer 
table report/layout. 

7. Link the Manufacturer table to the Models table using the 
Company field. 
 
Print out a copy of the relationship window showing the link 
between the tables. 
 

Printout/screendump of the 
relationship window 

showing the link between 
the tables. 

8. Mr. Hassan is only interested in buying televisions that are made 
in the United Kingdom.  He is looking for a television that has a 
screen size of at least 37 inches but not more than 42 inches.   
 
Produce a printout of a report/layout showing all the televisions 
made in the United Kingdom that have a screen size of at least 37 
inches but not more than 42 inches. 
 
The printout should show: 
The fields – Company, Manufacturing Country, Model, Price (£), 
Resolution, Screen Size (inches) and HD Ready. 
• The Price (£) field should be shown in currency format. 
• All details on the report/layout must be clearly visible. 
 

Printout of the televisions 
made in the United 

Kingdom with a screen size 
of at least 37 inches but not 
more than 42 inches using a 

report/layout as specified  
in 8. 

9. Meagan enjoys the full cinema experience when watching 
television.  McPhee’s has recommended that she go for a 
television with a 1080 resolution and either a Virtual Surround 
Sound system or a ProLogic II sound system.  Meagan would 
like a list of televisions that are most suitable. 
 
Provide Meagan with a list of all televisions that have a 1080 
resolution and either a ProLogic II sound system or a Virtual 
Surround Sound system.  The list of televisions should be in 
order of Price (£) starting with the cheapest.  If two or more 
televisions have the same price then they should be in order of 
Screen Size (inches) starting with the highest. 
 
The printout should show: 
The fields – Model, Sound System, Resolution, Price (£) and 
Screen Size (inches). 
 

Printout of all 1080 
resolution televisions with 

either a ProLogic II or 
Virtual Surround Sound 

system in order of Price (£) 
and Screen Size (inches) 

(16 marks) 
 
Collect all your printouts in the order they were asked for.  Ensure that your name is clearly visible on 
all printouts.  Hand all printouts to your assessor.
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Marking Grid 
 
Name    Date    
 

Topic Possible
Marks 

Marks 
Gained Comment 

Four Web pages created 1,0   
Text inserted and formatted as 
specified 

2,1,0   

Pictures inserted and formatted 
as specified 

2,1,0   Create website 

All hyperlinks/hotspots created 
and working as specified 

3,2,1,0   

Identification of three different 
types of object 

2,1,0   

Description of two operations 
provided to produce chosen 
object 

2,1,0   Evaluate 
application 

Evaluation of features of the 
online help 

2,1,0   

 
Field Types  2,1,0   Design of 

Manufacturer 
table Validation 1,0   

Creation of table 2,1,0   
Restricted Choice Field 1,0   
Accurate entry of Manufacturer 
data 

1,0   

Creation and printout of 
Layout/Report 

1,0   

Creation of 
Manufacturer 
table 

Linking of Manufacturer and 
Models table 

1,0   

Report/Layout showing:    
Correct fields shown and all 
information clearly visible 

1,0   

Price (£) in currency format 1,0   Complex 
search 

Select televisions made in the 
UK between 37 and 42 inches 
inclusive 

2,1,0   

 

Complex 
search and sort 

Select televisions with 1080 
resolution with either ProLogic 
II or Virtual Surround Sound 
system in order of Price and 
Screen Size 

3,2,1,0   

 
Overall total 30   
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CONFIDENTIAL – not to be issued to candidates 
Detailed Marking Guidelines 
 
The following guidelines assume that all work was carried out by the candidate on their own (or with 
the assistance of open book materials).  Any assistance by the assessor should be reflected in a 
reduction of the number of marks awarded. 
 
 
PART 1 

Four Web pages created 1,0 Four page website created – 1 mark 
 

Text inserted and formatted 
as specified 

2,1,0 Text inserted and formatted: 
• Page title text right aligned on 

all pages 
• TV details displayed in tables 
• Manufacturers names indented 

in navigation bar 
 
All 3 bullets satisfied – 2 marks 
Any 2 bullets satisfied – 1 mark 
Otherwise – 0 marks 
 

Pictures inserted and 
formatted as specified 

2,1,0 Pictures inserted and formatted: 
• All 6 graphics inserted and 

positioned as shown 
• All graphics scaled as shown 

(exact size not necessary) 
 
Both bullets satisfied – 2 marks 
Any 1 bullet satisfied – 1 mark 
Otherwise – 0 marks 

 

Create  
website 

All hyperlinks/hotspots 
created and working as 
specified 

3,2,1,0 Hyperlinks/hotspots created and working 
correctly: 

• Home link works on all pages 
• Bright link works on all pages 
• Both TV pictures link to TV 

details 
• Both TV model numbers link to 

TV details. 
 
All 4 bullets satisfied – 3 marks 
Any 3 bullets satisfied – 2 marks 
Any 2 bullets satisfied – 1 mark 
Otherwise – 0 marks 
 

 

Printout 0 No marks are awarded for taking the 
printout.  If printouts are not included 
then no evidence for the above would be 
available and so 0 marks for the work till 
now would be awarded. 
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Identification of three 
different types of object 

2,1,0 2 marks for 3 different types of objects 
1 mark for 2 different types of objects 
0 marks for 1 type of object that could 
be used in the production of the 
website.  e.g. table, navigation bar, 
hyperlink, hotspot, text, graphics. 
 

Description of two 
operations provided to 
produce chosen object 

2,1,0 2 marks for 2 suitable operations carried 
out on 1 object in the website.  
e.g. Serif Webplus 9 allows graphics to 
be inserted, scaled and rotated so that the 
television and McPhee’s logo can be 
included in the website.  Serif WebPlus 9 
allows a navigation bar to be inserted on 
the master page so that it doesn’t have to 
be created on every page.  The text in the 
navigation bar can be altered to 
hyperlinks so that links to the Home and 
Bright pages can be created. 
Similarly for hotspot, table or text. 
 

Evaluate 
Application 
(Serif 
WebPlus 9) 

Evaluation of features of the 
online help 

2,1,0 2 marks for 2 suitable features of the 
online help. 
e.g. Serif WebPlus 9 has a screenshot of 
all menus and toolbars so that you can 
simply click on the icon that you wish to 
know more about.  Serif WebPlus 9 has 
a searchable online help.  As you type in 
the word you are searching for, it 
predicts the word you are typing and 
scrolls through the list to that word. 
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PART 2 
 

Field Types 2,1,0 All field types correct – 2 marks 
<=2 mistakes – 1 mark 
>2 mistakes – 0 marks 
 

Design of 
Manufacturer 
table 

Validation 1,0 Warranty (years) field – Restricted 
choice (1,2 or 5) 
Candidates may try to put more 
validation in e.g. the country as a 
restricted choice or the Company field as 
a presence check.  These should be 
ignored without penalty. 
 

Creation of table 2,1,0 Accurate creation of table fields and 
field types as specified without any help 
– 2 marks. 
Some advice given – 1 mark. 

Restricted Choice Field 1,0 Warranty field set to restricted choice 1, 
2 or 5 – 1 mark. 

Accurate entry of 
Manufacturer data 

1,0 Accurate inclusion of all manufacturer 
data – 1 mark. 
>3 mistakes – 0 marks 
Case and alignment of text should not be 
penalised. 

Create and printout of 
Layout/Report 

1,0 Report created/printed without any help 
– 1 mark. 

Creation of 
Manufacturer 
table 

Linking of Manufacturer and 
Model tables 

1,0 Tables linked without teacher help – 1 
mark. 
Teacher help required – 0 marks. 

 
Report/Layout showing:   

Correct fields shown and all 
information clearly visible

1,0 Only specified fields are included and all 
clearly seen – 1 mark. 

Price (£) field set to currency 
format

1,0 Price (£) field set to currency format – 1 
mark. 

Complex 
Search 

Select televisions made in 
UK between 37 and 42 
inches inclusive. 

2,1,0 Complex search – 2 marks 
Only simple search – 1 mark. 
Otherwise 0 marks. 

 

Complex 
Search and 
Sort 

Select televisions with 1080 
resolution and either 
ProLogic II or Virtual 
Surround Sound system in 
order of Price and Screen 
Size. 

3,2,1,0 Complex search and complex sort – 3 
marks.   
Simple search and complex sort – 2 
marks, 
Complex search and simple sort – 2 
marks, 
Simple sort and simple search – 1 mark, 
otherwise 0 marks. 

 



Results for Task 8 
 

 
 
 
 
Results for Task 9 
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Photocopy Masters 
 



Database Design Form 

Name 
 
 
 

Date 
 

 
Company Founded Profit 

(£m) Logo Warranty 
(years) 

Manufacturing 
Country Finance 

Bright 22/05/1975 1045 
 

5 United Kingdom 18 months 

PixelPerfect 02/10/2005 22 
 

5 United Kingdom 24 months 

PowerZ 17/11/1988 356 
 

2 Japan 24 months 

TV2GO 30/12/1999 77 
 

1 USA None 

Vision 02/02/2002 6 
 

1 USA None 

Whyte 19/07/1982 14 
 

5 Russia 18 months 

 
• The warranty attribute can only take the values 1, 2, or 5 

 
Field Name Field Type Primary 

Key Validation 

Company 
 
 
 

Yes 
 

Founded 
 
 
 

No 
 

Profit (£m) 
 
 
 

No 
 

Logo 
 
 
 

No 
 

Warranty (years) 
 
 
 

No 
 

Manufacturing Country
 
 
 

No 
 

Finance 
 
 
 

No 
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Software Evaluation Form 
 
Name  Date  
Type of package  Name of package  
 
Identify three different types of data object used to create the website. 

 

Describe two operations used to produce one of the objects chosen. 
 

Evaluate the online help of the application used to create the website. 

 

 



Completed Database Design Form 
ONLY TO BE GIVEN OUT TO CANDIDATES AFTER THEY HAVE 

SUBMITTED THEIR OWN DATABASE DESIGN FORM 
 

Company Founded Profit 
(£m) Logo Warranty 

(years) 
Manufacturing 

Country Finance 

Bright 22/05/1975 1045 
 

5 United Kingdom 18 months 

PixelPerfect 02/10/2005 22 
 

5 United Kingdom 24 months 

PowerZ 17/11/1988 356 
 

2 Japan 24 months 

TV2GO 30/12/1999 77 
 

1 USA None 

Vision 02/02/2002 6 
 

1 USA None 

Whyte 19/07/1982 14 
 

5 Russia 18 months 

 
 The warranty attribute can only take the values 1, 2, or 5 

 
Field Name Field Type Primary 

Key Validation 

Company 
 

TEXT 
 

Yes NONE 

Founded 
 

DATE 
 

No NONE 

Profit (£m) 
 

NUMBER 
 

No NONE 

Logo 
 

OBJECT 
 

No NONE 

Warranty (years) 
 

NUMBER 
 

No RESTRICTED CHOICE 
(1,2 OR 5) 

Manufacturing Country
 

TEXT 
 

No NONE 

Finance 
 

TEXT 
 

No NONE 
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